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Synchronizing your Psion with
Microsoft Outlook

This document details the set-up and day-to-day use of PsiWin 2.3 to synchronize your Psion Series
3a, 3¢, 3mx, 5, 5mx, 7, Sienaor Revo Agenda and Data files or Contacts program (5mx/7/Revo) with
Microsoft Outlook 97 or 98 on the PC. The document does assume some basic familiarity with the use
of Windows 95, 98 or NT 4.0.

Software compatibility

The details for this document assume that you are using version 2.3 of PsiWin. To check which
version of PsiWin you have, double-click the My Psion icon on your desktop, and select About
PsiWin 2.x from the Help menu. If you have at least Build 136 then you have version 2.3. If you have
aprevious version of PsiWin 2.x, you will find a section on earlier versions towards the end of this
document.

Y ou must also have afull local installation of Microsoft Outlook 97 or 98.

Creating new synchronizations

Y ou can create multiple synchronizations on your PC should you have different Agenda or Datafiles,
or Outlook folders that you wish to synchronize. See the section on creating multiple synchronizations
towards the end of this document. Y ou will need to define at least one synchronization.

Required information
Before creating your synchronization, you will need to note the locations of the files you wish to
synchronize.

1. From the Series 3a, 3c, 3mx, 5 or Sienayou may synchronize your Agendaor Data files, while
from the Series 5mx, 7 or Revo you may also synchronize with the Contacts program. If you are
synchronizing an Agendaor Datafile from a Series 5, 5mx, 7 or Revo, open thefiles
you wish to synchronize.
Tap the filename at the top
of the toolbar and you will
see the Open files/
programs dialog. Scroll
through the list until you
find your file(s) listed. Make
anote of the path (in this
example, c:\Work\Agenda).

Agenda
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2. If you have a Series 3a, 3¢, 3mx + DiskInternal, 467K free  + +No
or Siena, highlight the file(s) that SAGHNN> Me
you wish to synchronize and N “AGN™
press Tab. Thetop line of this Wa i B
dialog will tell you on which NLI;

Disk thefileis stored, in this 201
example, Internal. | 14th)

Sys

The fourth line tells you the path to the file (in this example, \AGN\) and the highlighted line tells
you the filename (in this example, Agenda.agn). So, the location of the file will be:

[Disk]:[Path tofile][Filenamg], in this example, M :\AGN\Agenda.agn. Press Esc to remove
thisdialog. Note that if the fileis on the Internal disk then [Disk] will be M. If itison the A or B

disks then [Disk] will be A or B.

Creating the synchronization

1. Make surethat your Psion is connected to the PC, then double-click on the My
Psion icon. Assuming the machines have linked successfully, you will see several
icons, including one labelled Psion Synchronizer. Double-click on thisicon.

In the Psion Synchronizer window,
click the New button. Thiswill launch
the Psion Synchronizer Wizard, which
will take you through the steps required
to set up the synchronization. If you
have never created a synchronization
before, PsiWin will bypass this window
and go straight to the Synchronization

L} Psion Synchronizer

Psion
Synchroni...

NE =
Synchronize |
Automatic... |

| Delete Properties... Help | LClogze |

Wizard.

2. Thewelcome page of the Wizard asks you the PC Lofus Drgarizer 21
Personal Information Manager (PIM) with which Lotus Ordanizer 37 G5
you wish to synchronize. Highlight the relevant
option and click the Next button.
Cancel | Help |
3. Onthe Applications page, you will need to enter Lot i) b P .
the path(s) for the file(s) you wish to synchronize. _n?Scees;rSnygo\g;IJSr:wsnlaef[losr]'eb:islt?gg s which %ﬁ?laﬁq;éﬂ?fl'
information. Y'ou may alsa need to enter your Dutlook, details.
In the Psion section, you will need to specify the ~ Bsion = :
Psion files with which you wish to synchronize. If I::\f\f;c:;fg”jd';"y faencs =
you wish to synchronl Zzean Agendf_:lfl!e, ensure that 2] Symehverize My Contacts
the Synchronize My Agenda box isticked. You [Contacts program ]
will then need to specify the Agendafileto be YT
SynChronizw. YOU can eI'[hel’ '[ype in the path and Calendar Folder IPersonaI Folders\CalendarE xample]
filename you noted earlier or click the_-| button to I Use Default Calendar Folder
browse the Psion’s disks. If in doubt, use the browse TaskFolder |
button to f| nd yOUI’ f| I e. ¥ Use Default Task Folder
If you wish to synchronize a Datafile or the |
Contactz Folder:
Contacts program (5mx/7/Revo), ensure that the ¥ Use Default Contacts Folder
Synchronize My Contacts box isticked. The next Evchange Seltings... |
step depends on whether you are synchronizing with
gi Series 5mx, 7 or Revo or a Series 3a, 3¢, 3mx, 5 or et e | cwed | [ e |
ena.
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Series 3a, 3¢, 3mx, 5or Siena

Next, you need to specify the Data file to be synchronized. Y ou can either type in the path
and filename you noted earlier or click the _-| button to browse the Psion’s disk(s). If in doulbt,
use the browse button to find your file.

Series5mx, 7 or Revo

If you wishto synchroni ze with the Contacts program, Select the Psion program wou wish to uge for this
you should leave the next box as Contacts program. If | contasts synchroniztion

you wish to synchronize with a Datafile, click the _- © Contacts program

button. Next, select Data and specify the Datafile to & Data

be synchronized. Y ou can either typein the path and
filename you noted earlier or click the__-| button to
browse the Psion’ s disk(s). If in doubt, use the browse
button to find your file. Next, click the OK button.

File: |csDocurmentshOutlook Contacts |

Cancel |

4. Next, you need to enter details for Microsoft Outlook. If [ eqiger List x|
you wish to synchronize the standard Outlook folders ~ &¥ Outlook Today - [Personal Folders]
then leave all the Use Default... boxesticked. If you - % Calendar
wish to synchronize custom Outlook folders, you will 2 Example

need to untick the relevant Use Default... box and enter
the folder path. Y ou can find the folder path by looking

at the Folder List in Outlook. If you do not have this [ Mierasft 0utock S
shown, select Folder List from the View menu. Expand | baiendar Felder I_B'ZmaD : T[Z laed" E'F[ ldxampe
thelist until you can see the folder you wish to il
synchronize. The path will be: the top level folder, then Tosk Folder |

the subfolder that contains the folder(s) to synchronize, [4] Use Defauit Lask Folder

then the folder to synchronize. These should be Contacts Foider |

separated by backslashes (\). If the name of your top 2l Use Defauk Contacts Folder

level folder contains some text in square brackets, use _ Exchange Settings .|

thistext instead of the top level folder name. In the example shown here, the path to the Example
folder is Personal Folders\Calendar\Example. Y ou should then enter this information into the
Applications dialog of the Synchronization wizard. Untick the relevant Use Default... box, in
this example, Use Default Calendar Folder, and type the path into the box (in this example the
Calendar Folder box).

Once this information has been entered, click on the Next button. Note that it is very important
that thisinformation is entered correctly —if it is not, the wrong files may be synchronized, or no
synchronization will occur. However, if you do not have an existing Agenda or Database file on
your Psion, the synchronizer can create them. Thisis especially useful for a Contacts database - if
you specify anon-existent Psion Datafile, the synchronizer will create a new one on the Psion
that is optimised for use with your Outlook contacts. If you are synchronizing with a Series 5mx,
7 or Revo, the synchronization can only create a Datafile if you have selected the option to
synchronize a Datafile.

Click on the Exchange Settings... button, enter aprofile
name and click the OK button if you wish to . . . N .
A . A elect a Profile from the list below. If the profile you wish to use is
synchronize with an Outlook profile other than your rot present ther typs it nto the bos.
PC's defaullt. I =
Ok I Cancel |
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6. The next page allows you to specify which types of
entry you wish to synchronize. Y ou can untick

Select the entry types to be synchionized between pour Psion and

particular entry typesif you do not want them to be PC Agendas.
synchronized.

Click the Next button when you have selected the [FEnt e taismehiohie
entry types.

M Anniversaries / Annual Events

W Exvents

M Toedos / Tasks

< Back I Hext > I Cancel | Help |

7. To specify the period of entries you wish to

synchronize, click the Set date range button, select
the period required and click the OK button.

r Synchronize Agenda entrie:
From: 1 Monthig] in the past.

To specify how the synchronization will deal with Te & Monthis] in the future. Setd
entries outside of normal working hours, select the Agenda enkies to synchronize
appropriate option from the Agenda entriesto © #llspecited enties o
. . = All zpecified entries, but make entries autzide work, haurs
synchronize section. Y ou can also change your private on the PC
work hours by clicking the Set work hour s button, € Dnly entiies within your otk hours
altering the settings as appropriate and clicking the
OK button Days: Man Tue Wed Thu Fri

Hours:  3:00am-5:30pm Set work haurs

Next, click on the Advanced button to set up the
label mapping. Note that if you are synchronizing

r Contacts details to synchronize

The Synchronizer will prompt pou if you need ta change any

with the Contacts program, or have chosen not to contact synchrorization seftings.

i i i Click Ad d to check th t
e o e ey | | PRI (g
below and click the Next button.

< Back Mext = Cancel | Help |
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8. The Contacts Synchronization page shows atable,
listing the labels for the Contacts folder in Outlook
(or whichever folder you have specified for contacts
information) in the Contact infor mation column,
and in the Psion label column you can match these
to their equivalents (if any) in your Psion Datafile.

é_.% Contacts Synchronization

x]

The lizt below shows the Outlook fields which you can synchronize with
wour Psion address book, and the Psion labels with which they will be

synchronized.

If you want to synchronize a Outlook field with a different Pzion label
from that which is dizplayed, click in the Psion label box nest to the
appropriate Outlook field and zelect from the available Psion labels.

To match labels: —— -
. . . . Contact information | Pzion label | -
i. Find the Outlook label whose function isthe Name, s Lest Heme:
. . ame, Mrsl Irt Name:
same as one of your Psion Datafile s labels, Name, middis
then click in the box next to it in the Psion label o Lompaty.
Jab tith Job Title:
COI umn. BTJS!I’:EESS a_ddless = |
ii. An arrow = will appear to the right of Fhis box. Ejﬁ;ﬂ:iﬁ eie/orovince lanare (2]
If you click on this, a drop-down list will Business ZIP/postal code ork Tel 2 —
.. . Buziness country K Fax:
appear, containing all the Psion labels that you Home adess viihe
. 1y . -
have not matched. Select the label you wish to DO Pager. -
ass' gn E miail: hd
iii. 1f you do not wish to synchronize with a oK Concel | Hep |

particular Outlook label, you should select
<lgnore> from the drop-down list

Note that each Psion label can only be matched to one Outlook label.
9.  When you have finished matching the labels, click the OK button and then the Next button.

10. The last page of the wizard is ssmply a confirmation screen. If you wish to start the
synchronization process immediately, click on the Synchronize Now button, otherwise click on
the Finish button to complete the set-up and save the synchronization.

If thisisthe first time you have run the synchronization, you may see the Contacts
Synchronization dialog described in Step 8 above. If there are any |abels on the Psion that cannot
be directly mapped, the synchronization will prompt you to do this by hand.

Using an existing synchronization

Once you have set up the synchronization as above, you can use it whenever you wish. To run an
individual synchronization:

1. Connect your Psion and PC.

2. Double-click onthe My Psion icon, and then double-click on the Psion synchronizer icon.
3. Click ontheicon for the desired synchronization(s) so that they are highlighted.
4. Click on the Synchronize button.

Synchronizing with older versions of PsiWin 2

Y ou can still synchronize with older versions of PsiWin 2. All versions older than 2.2 will only let
you synchronize with a Series 5 and require that the files to be synchronized are closed. To do this,
highlight the file(s) on the system screen of the Psion and press Ctrl + E. Also, ensure that Outlook is
closed on the PC. Versions 2.0 and 2.01 do not work with Microsoft Outlook. Version 2.1 will not
work with Outlook 98. The user interface of previous versions will look dlightly different from the
dialogs shown here, but al the information required is the same. Note that PsiWin 2.3 must be used to
synchronize with a Series 5mx, 7 or Revo.
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Multiple Synchronizations

It is possible to synchronize multiple Agenda and Datafiles or
Outlook folders. To do this you will need to set up multiple
synchronizations. To do this you may need to create extra
Outlook folders. You can do this by selecting New, then
Folder ... from the File menu. Type in aname for the new
folder, select the type of itemsto be stored in the folder (in this
example, Contact Items), select the folder to create the new
folder in and click the OK button.

When you create the synchronization, enter the appropriate
paths and filenames in the applications dialog.

Create New Folder [ 7] x|

Mame:

2 [ > |
Folder contains: _I Cancel |
-

IContact Items

Make this folder a subfolder of:

=-173 Personal Folders -~
% Calendar
= @ Contacts
2 Business

42 Personal
@ Deleted Items
&2 Inbox
(ﬁ Journal
Notes
Outbox
2 -]

IF Sent llems

Description:

[ Create a shortcut to this Folder in the Qutlook Bar

Applications

Use the suggested Psion file(z), which Psiwin can create for

vau if necessary, or browse far existing files which contain pour

infarmation, Y'ou may alzo need to enter your Outlook details.
[T Synchranize My Agenda

- Psion
¥ Synchronize My Contacts
@ |c:\D ocuments\Extra |

~ Microsoft Dutlook

Calendar Folder: |
[¥] Uss Distaul Calendar Faldes

Task Folder: |

[¥] Use Defaul Task Falder

|Pernna| Falders\Contacts\E xira

[T Use Defalt Contacts Falder

Contacts Folder:

Exchange Setlings I

Back: I Ment > I Cancel | Help I

Note: Y ou should never synchronize multiple Psion files with a single Outlook folder or multiple
Outlook folders with asingle Psion file as this will result in the multiple files being mixed together.
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